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Month-end procedures usually are performed at the end of every month, but they can be done at any time
during the month. The key to success is to perform these tasks regularly. Some tasks need to be performed
at a specified time every month. Consult your accountant if you're unsure which of these tasks are required
for your business.

Reviewing and printing your trial balance

Reviewing a trial balance report-also known to accountants as a general ledger-regularly is an optional
month-end task, but it can make your job easier in the future. If you regularly review your trial balance,
you'll spot incorrectly recorded amounts quickly and will be able to fix them without much effort. If you
decide to skip this procedure, however, and an error appears, you may find yourself sifting through several
month's worth of transactions trying to find the one that's incorrect.

Click below for the step-by-step procedure:

To print a trial balance (or general ledger)

To review your trial balance

Reviewing and adjusting budgets

Reviewing the monthly amounts you've budgeted for your accounts will help you keep your fingers on the
pulse of your business. The best way to do this in AccountEdge is to consult a special balance sheet, called
the Analyze Balance Sheet, that's designed specifically for budget analysis.

You can print the Analyze Balance Sheet report, which lists your accounts' actual balances for the current
month, along with the amounts you budgeted for them. If you want information about customizing the
Analyze Balance Sheet report, see Choosing settings for a specific report. Please note, though, that you
don't need to make any modifications to print the balance sheet in its standard format.

If you've determined that changes need to be made to the amounts you've budgeted for the coming
months, you can adjust your budget.

Click below for the step-by-step procedure:



To print a balance sheet for budget analysis

To review your budget

To change a budgeted amount

Reviewing cash flow

Having an acceptable supply of available cash can often make a huge difference in determining how well
your company performs next month. In AccountEdge, you can use the Cash Flow Worksheet window to
estimate your short-term cash needs by using information you've entered throughout AccountEdge to create
a forecast of your checking accounts' future.

The information used in the Cash Flow Worksheet window to forecast cash needs comes from recurring
Spend Money and Receive Money transaction information that you've entered in AccountEdge, as well as the
sales and purchases that will fall due during the time frame you've selected.

Because each company's business practices are unique, we can't tell you precisely what you should look for
when reviewing your cash flow. See Reviewing cash flow for some ideas. Your accountant can give you
additional ideas based on the way your company does business.

Click below for the step-by-step procedure:

To review cash flow

Reviewing items' order status

Knowing what items you have on hand is fairly simple. Knowing which items are on order from vendors and
promised to customers is more complicated. Many businesses keep what they call an "order book." It's what
they use to track the comings and goings of inventory items.

The Analyze Inventory window functions as your "order book" by monitoring what you have:

On hand●   

On order (purchase orders) from vendors●   

On backorder (sales orders) to customers●   

The Analyze Inventory window allows you to review the current status of the items you've entered into the
MYOB system. The fields in this window are display-only; that is, you can't change any of the information
using this window. You should note that the Analyze Inventory window shows quantity information only. If
you want to see past sales activity of items, use the Analyze Sales window to do so.

Click below for the step-by-step procedure:

To review your items' order status

Purging information that's no longer needed

After you've used AccountEdge for a long time, you'll notice that the size of your data file has grown
considerably. Information such as journal entries, invoices, bills, activity slips and business contacts build up
over time. When your data file has grown larger than you want it to, you may want to remove the parts of
the data that are no longer needed from the file. The process of removing data from your data file is called
purging.

When you purge information from your records, you should plan out a strategy to do so. We strongly
recommend that you purge your information in the following order:

Closed invoices1.  

Closed bills2.  

Journal entries3.  
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Activity slips4.  

Business contacts can be purged at any time.

You can purge activity slips that haven't been billed on invoices. If you've billed an activity slip on an
invoice, you can purge that activity slip only if the invoice on which it was billed has been purged.

Click below for the step-by-step procedure:

To purge closed invoices

To purge closed bills

To purge journal entries

To purge activity slips

To purge business contacts

Viewing transactions after purging

If you choose Purge Detail Only when purging sales and purchases the detail information that was entered in
the scrolling list section of the sale or purchase will be removed; information, such as, ID number, date,
customer or vendor name, memo, comment, salesperson and vendor invoice number or customer purchase
order number for each closed sale and purchase will remain. The zoom arrow that appears before journal
entries for these sales and purchases will be gray. Click the zoom arrow to display the window in which the
original transaction was entered -- detail information mentioned above will not display. You won't be able to
make any changes to this window.

If you choose Purge Entire Sale or Purge Entire Purchase, all information about the closed sales and
purchases will be removed. The journal entry will remain in the Sales or Purchases Transaction Journal
window, but no zoom arrow will appear; you'll no longer be able to display the window in which the original
transaction was entered.

If you purged entire closed sales or purchases and you wish to also remove the journal entries for these
closed transactions from the Sales or Purchases Journal, follow the steps for To purge journal entries.

Click below for the step-by-step procedure:

To view purged information using the Sales Journal -- if you purged detail only

To view purged information using the Purchases Journal -- if you purged detail only

Reconciling checking accounts

To ensure the accuracy of your business records, you should keep a record of your checking accounts'
balances matched up with your bank's records. This task is called reconciling accounts.

Once you've made sure all the checks and deposits that appear on your bank statement are entered in
AccountEdge, you're ready to reconcile your account.

If your account is out of balance, a window will indicate the amount by which your account is out of balance,
and will provide you with a few ideas of how the out-of-balance situation might have occurred. Here are
some additional things you might want to verify:

Are all the checks and deposits that appear on your bank statement marked in the Reconcile
Accounts window? Check to be sure the deposit and withdrawal amounts that appear on the Total
Cleared line near the bottom of the Reconcile Accounts window are the same as the total deposit and
withdrawal amounts on your bank statement.

●   

Did you mistakenly mark a transaction that doesn't appear on your bank statement?●   

Did you make the correct entry in the New Statement Balance field? (Be sure you entered the●   



ending balance from your statement, not your beginning balance.)

Are all deposits accounted for? If the bank statement shows a higher balance than the balance
calculated by AccountEdge, a previously cleared deposit may have been deleted and not reentered,
or reentered but not marked as cleared.

●   

If you decide to exit the Reconcile Accounts window without successfully reconciling a checking account, the
transactions marked as cleared remain marked. You can pick up where you left off at any time.

If you wish, you can enter bank service charges and interest using the Reconcile Accounts window. You'll
click the Bank Entry button to open the Bank Entry window. If you've received bank service charges, enter
an amount in the Service Charges section. If the account you're reconciling is a Detail Checking Account, the
bank fee, when recorded, will appear as a check transaction assigned to the checking account you're
reconciling. The next available check ID number is assigned to the transaction. (If the account you're
reconciling is a Detail Account, a General Journal entry will be recorded.) Verify the date and enter the
account you wish to allocate the charges to (usually an expense account). Add a memo if you wish.

If you received interest, you'll enter an amount in the Interest Earned section. If the account you're
reconciling is a Detail Checking Account, the interest, when recorded, will appear as a deposit transaction
assigned to the checking account you're reconciling. The next available deposit ID number is assigned to the
transaction. (If the account you're reconciling is a Detail Account, a General Journal entry will be recorded.)
Verify the date and enter the account you wish to allocate the bank interest to (usually an income account).
Add a memo if you wish.

To reconcile an account for the first time

Most likely, some of the checks you wrote and some of the deposits you made before you began using
AccountEdge will be reflected in your bank statement when you reconcile an account for the first time using
AccountEdge. In order to reconcile the account, these transactions must also appear in the Reconcile
Accounts window, but, since you conducted the transactions before you began using AccountEdge, there will
be no AccountEdge record of those transactions. This situation must be resolved before you can reconcile
the checking account.

To resolve the situation, you'll create a general journal entry-using the amount of each of the uncleared
check and deposit transactions you conducted before using AccountEdge-that debits and credits the
checking account you want to reconcile.

For example, say you made one deposit and wrote four checks with your checking account before you began
using AccountEdge, and those transactions haven't cleared the bank yet. In the General Journal Entry
window, the deposit amount would appear in the Debit column and the check amounts would appear in the
Credit column

Since the general journal entry debits and credits the checking account for the same amount, the journal
entry will not affect the balance of the checking account. It will, however, appear in the list of transactions
to be reconciled in the Reconcile Accounts window.

Click below for the step-by-step procedure:

To reconcile an account

To reconcile an account for the first time using AccountEdge

Paying payroll taxes

Like sales tax, payroll taxes need to be paid on a regular basis. Consult your accountant or the appropriate
government agencies if you're unsure about how or when to file payroll taxes.

You can use the Tax Liabilities Report to determine the taxes you owe to the government agencies.

Click below for the step-by-step procedure:

To print the Tax Liabilities Report



Other month-end procedures

Many procedures in AccountEdge can also be considered month-end procedures. The following procedures
might be performed at the end of the month at your company; we suggest you click on the links below to
learn how to perform these tasks.

Printing customer statements

Most businesses send statements of sales activity to their customers at the end of each month. See Printing
statements for more information.

Analyzing sales

It's a good idea to be aware of your company's sales activity and trends on a month-by-month basis. The
Analyze Sales window can provide you with a graphical representation of your monthly sales. See Reviewing
your sales information for more information.

Analyzing purchases

Tracking your company's monthly expenses is a wise business practice. See Reviewing your purchase
information for more information.

Counting items in inventory

Staying on top of your inventory quantities can make the difference between making sales and losing sales.
Therefore, it's a good idea to check your current inventory levels at regular intervals and be sure your
AccountEdge records match your actual quantities. See Counting inventory items for more information.

Recording unrealized gains and losses

If you use the Multicurrency feature of AccountEdge, you may need to make a journal entry to record your
company's unrealized gains and losses for the current month and reverse the previous month's entry. See
To record unrealized gains and losses for more information.

Closing accounting periods

AccountEdge doesn't require you to close accounting periods. The things you do to "close" an accounting
period are more for the sake of keeping track of your periodic business activity, so you have accurate
historical records to refer to in the future. As a result, the tasks listed below are merely suggestions-but
they're suggestions that may help you out a great deal someday.

Accounting Plus allows you to "lock" the closed accounting period to prevent you from inadvertently making
an entry in a month in which you don't want new entries. This "lock" affects the month you select and all
months before it. If, at a later time, you need to make an entry in a month that occurs before the month
you selected here, simply change your selection here so that month is "unlocked" and available for
transaction entry again.

Click below for the step-by-step procedure:

To close an accounting period

Month-end Procedures Overview
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Note: Purging is based on your current fiscal year setup When you select the month before which you
want to purge, AccountEdge checks the current fiscal year of your data file and uses the selected month of
your current fiscal year as the basis for deciding which transactions to purge. Before you purge, check the



current fiscal year of your data file using the Company Information window.
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To print a trial balance (or general ledger)

If you haven't already read the Month-end Procedures Overview, see Reviewing and printing your trial
balance for more information.The Index to Reports window should be displayed

Select the General Ledger tab to display a scrolling list of reports that are associated with the
General Ledger Command Center.

1.  

Highlight the Trial Balance (Detail) selection.2.  

Click the Filters button. Make account, date and sort selections.3.  

Choose the option Include Accounts with No Activity if you wish to display all accounts, even those accounts
that have no transactions recorded between the beginning and ending dates that have been selected for this
report.

Click OK to redisplay the Index to Reports window.4.  

Click the Print button.5.  

To print a trial balance

© MYOB Limited. All rights reserved.
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To review your trial balance

If you haven't already read the Month-end Procedures Overview, see Reviewing and printing your trial
balance for more information.

When you review the report, look for:

Entries that seem unusually high or low for the account that's been affected●   

Debit amounts for accounts that normally have credit entries, and vice versa●   

Unusually high or low ending balances●   

An unusually high or low number of entries for a specific account●   

To review your trial balance

© MYOB Limited. All rights reserved.



To print a balance sheet for budget analysis

If you haven't already read the Month-end Procedures Overview, see Reviewing and adjusting budgets for
more information.

The Index to Reports window should be displayed.

Select the General Ledger tab to display a scrolling list of reports that are associated with the
General Ledger Command Center.

1.  

Highlight the Balance Sheet (Budget Analysis) selection.2.  

Click the Filters button; the Report Filters window appears. Check to be sure that the correct month
has been selected for the report; also be sure that level 4 is selected, so you can see comparison
information for all the accounts in your chart of accounts.

3.  

Click OK to redisplay the Index to Reports window.4.  

Choose the Print button.5.  

To print a balance sheet for budget analysis

© MYOB Limited. All rights reserved.
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To review your budget

If you haven't already read the Month-end Procedures Overview, see Reviewing and adjusting budgets for
more information.

When reviewing the Analyze Balance Sheet report, begin by looking at the $ Difference column on the right
side of the report. This column shows the difference between the amount you budgeted to spend during the
month and the amount you actually recorded for each account in your chart of accounts. Many accounts will
have a slight variation from the amount you've budgeted-that's normal. What you're concerned with is an
unusually large departure from the amount you've budgeted.

Here are some differences that should be of particular concern to you:

Sales accounts that are lower than projected.●   

Expenses that are higher than you'd planned. If your expenses often exceed your expectations, you
may need to put spending controls in place.

●   

Wage or salary expenses that are different than you'd planned. This could mean you're paying more
overtime than you'd planned to, for example.

●   

Inventory balances that are significantly different than you'd projected. This could mean that you've
got too much-or too little-inventory on hand. Both of these situations can create a financial drag on
your business.

●   

Accounts payable that are higher than expected. Accounts payable need careful management to
ensure that you're not paying your bills before you have to, but also aren't losing discounts and
paying unnecessary interest charges.

●   

Accounts receivable that are higher than expected. This may mean that your customers are taking
longer than anticipated to pay off their accounts with you.

●   

Any significant variation from the amount you've budgeted deserves further investigation, but these are key
areas for you to consider.

To review your budget

© MYOB Limited. All rights reserved.

Idea: If you need to change your budgets Make a note on the report of any changes that are needed to
your budgets for future periods. That will make your next task-adjusting the budgets-easier.



To change a budgeted amount

If you haven't already read the Month-end Procedures Overview, see Reviewing and adjusting budgets for
more information.

The Accounts List window should be displayed.

Highlight an account you want to change.1.  

Click Edit. The Edit Accounts window appears, displaying information about the account.2.  

Click the Budgets button to display the History and Budgets window.3.  

Make any needed changes to the amounts displayed in the Budget column.4.  

Remember to enter only the expected change (increase or decrease) in the account's balance; don't enter
the expected balance for the account during the month in question. Also be sure to enter a positive amount
if you expect the account's balance to rise. Even if the amount represents an expense to your company, it
should be positive if it causes the account's balance to rise.

Click OK.5.  

Click OK in the Edit Accounts window to redisplay the Accounts List window.6.  

Select another account if you need to make additional budget changes, or click Close if you don't
have any more changes to make.

7.  

To change a budgeted amount

© MYOB Limited. All rights reserved.
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To review cash flow

If you haven't already read the Month-end Procedures Overview, see Reviewing cash flow for more
information.

The Cash Flow Worksheet window should be displayed.

Choose the checking account you want to analyze from the Checking Account list.1.  

Enter the number of days for which you want to analyze your cash needs in the Days To Look Ahead
field. When you make your entry here, the list in the middle of the window will display all the
transactions your company is due to perform during the time period you specified. Any transactions
that are overdue also appear here.

2.  

You can change any of the information that appears in the list to better estimate your cash flow
needs.

3.  

You can also add transactions to the list. To do this, scroll to the bottom of the list and add transaction
information in the blank line. When you're finished, press tab to create a new blank line, where you can
enter additional transaction information.

Click the Analyze Cash Needs button at the bottom of the window.4.  

A new view of the Cash Flow Worksheet window appears, listing all the transactions that appeared in
the previous list. Their corresponding amounts appear in the Amount column. The running balance
of the account as it is affected by each transaction appears in the Cash Available column. You can
simply view the information here if you like, or you can click the Print button to print a copy of the
Cash Flow Analysis Report that contains the information displayed on your computer screen.

5.  

Click the Return to Worksheet button and make more changes to the list of transactions, if you wish.
Experiment with the two views of the window to make different forecasts of your account.

6.  

Click Cancel.7.  

To review cash flow

© MYOB Limited. All rights reserved.

Note: The Cash Flow Worksheet doesn't affect your data file Changes, deletions and additions you
make in the list are used for the purposes of the Cash Flow Worksheet window only. The changes you make
here won't be reflected anywhere else in the MYOB system.
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To review your items' order status

If you haven't already read the Month-end Procedures Overview, see Reviewing items' order status for more
information.

The Analyze Inventory window should be displayed.

Two different views are available in the Analyze Inventory window: Summary and Detail.1.  

Summary view This view is displayed by choosing the Summary selection at the top of the window,
allows you to view quantity information for all items in the MYOB system. This view shows the actual
quantity on hand for each item, as well as number of items committed on sales orders, on order on
purchase orders, and available.

●   

Detail view This view is displayed by entering a specific item number in the Item # field at the top
of the window, allows you to view order information for a single item at a time. The Detail view can
also be displayed from the Summary view by clicking the zoom arrow next to an item's number.

●   

To review your items' order status

© MYOB Limited. All rights reserved.
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To purge closed invoices

If you haven't already read the Month-end Procedures Overview, see Purging information that's no longer
needed for more information.Please note that this task requires single-user access. See Single-user file
locking for more information.

Print all the reports that you wish to keep that show the closed sales you'll be purging. You might
consider printing a copy of the Sales Journal, which contains detailed information about all sales.

1.  

Make a backup of your data file. Clearly mark this backup and put it in storage as part of your
permanent records.

2.  

Open the Sales Command Center.3.  

Choose Purge Closed Invoices from the File menu. The Purge Closed Invoices window appears.4.  

From the Purge Invoices Close BEFORE list, choose the first month for which you don't want to
remove closed invoices. Be especially careful when you select a month-don't include an accounting
period that isn't completely closed. All closed invoices dated prior to the month you select are
marked for purging.

5.  

Choose to purge detailed information about closed invoices only, or to purge entire closed invoices.6.  

Click the Continue button. Another Purge Closed Invoices window appears, listing all customers in
the Card File.

7.  

From the list of customers, select the customers whose closed sales you want to purge. If you wish
to keep closed invoices for any customers, remove the x that appears next to each of the customers'
names by clicking it.

8.  

Click the Purge Closed Invoices button. The closed invoices for the time frame you specified and for
the customers you selected in this window will be removed.

9.  

To purge closed invoices

© MYOB Limited. All rights reserved.

Warning: Purging information will change the way you view your financial activity Various types of
information, including journal entries, closed sales and purchasing transactions, activity slips and contact
logs, can be removed from a data file. The information you can remove won't prevent you from keeping
accurate financial records, but removing some types of information could change the way you analyze your
information. We suggest you carefully consider the results of purging data from your data file before you do
so. Although you can recover the information from a backup copy of the data file, the process may take
more time and effort than you're willing to invest.



To view purged information using the Sales Journal -- if you purged detail only

If you haven't already read the Month-end Procedures Overview, see Viewing transactions after purging for
more information.The Transaction Journal window should be displayed.

Use the scroll bar to find the purged sale you want to view.1.  

Click the zoom arrow next to the closed invoice to view the original window in which the transaction
was entered, displaying only the information that wasn't purged.

2.  

If you purged entire closed invoices, you won't be able to view any details about the invoice, other than
those that appear in the Sales Journal.

To view purged information using the Sales Journal -- if you purged detail only

© MYOB Limited. All rights reserved.
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To purge closed bills

If you haven't already read the Month-end Procedures Overview, see Purging information that's no longer
needed for more information.Please note that this task requires single-user access. See Single-user file
locking for more information.

Print all the reports that you wish to keep that show the closed bills you'll be purging. You might
consider printing a copy of the Purchases Journal, which contains detailed information about all
purchases.

1.  

Make a backup of your data file. Clearly mark this backup and put it in storage as part of your
permanent records. (If you've just purged closed sales and made a backup during that procedure,
it's not necessary to make a second backup for purchases.)

2.  

Open the Purchases Command Center.3.  

Choose Purge Closed Bills from the File menu. The Purge Closed Bills window appears.4.  

From the Purge Bills Closed BEFORE list, choose the first month for which you don't want to remove
closed bills. Be especially careful when you select a month-don't include an accounting period that
isn't completely closed. All closed bills dated prior to the month you select will be marked for
purging.

5.  

Choose to purge detailed information about closed bills only, or to purge entire closed bills. If you
choose Purge Detail Only, the purchase ID number, date, vendor, shipping method, comment,
shipping date, tax, freight, memo and vendor invoice number for each closed purchase will remain.
If you choose Purge Entire Purchase, all information about the closed bills will be removed.

6.  

Click the Continue button. Another Purge Closed Bills window appears, listing all vendors in the Card
File.

7.  

From the list of vendors, select the vendors whose closed bills you want to purge. If you wish to
keep closed bills for any vendors, remove the x that appears next to each of the vendors' names by
clicking it.

8.  

Click the Purge Closed Bills button.9.  

To purge closed bills
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To view purged information using the Purchases Journal -- if you purged detail only

If you haven't already read the Month-end Procedures Overview, see Viewing transactions after purging for
more information.The Transaction Journal window should be displayed.

Use the scroll bar to find the purged purchase you want to view.1.  

Click the zoom arrow next to the closed purchase to view the original window in which the
transaction was entered, displaying only the information that wasn't purged.

2.  

If you purged entire closed bills, you won't be able to view any details about the purchase, other than those
that appear in the Sales Journal.

To view purged information using the Purchases Journal -- if you purged detail only

© MYOB Limited. All rights reserved.

file:///C|/^^^^^US 10 PDFs/_Mac/PDFOutput/570000c.fm


To purge journal entries

If you haven't already read the Month-end Procedures Overview, see Purging information that's no longer
needed for more information.Please note that this task requires single-user access. See Single-user file
locking for more information.

Print all the reports that you wish to keep that show the transactions you'll be purging. Account
inquiry reports contain most of the information you may want to retain.

1.  

Make a backup of your data file. Clearly mark this backup and put it in storage as part of your
permanent records. (If you've just purged closed sales or purchases and made a backup during one
of those procedures, it's not necessary to make another backup for journal entries.)

2.  

Open the General Ledger Command Center.3.  

Choose Purge Journal Entries from the File menu to open the Purge Journal Entries window.4.  

From the Purge Journal Entries BEFORE list, choose the first month for which you don't want to
remove journal entries. Be especially careful when you select a month-don't include an accounting
period that isn't completely closed. All journal entries dated prior to the month you select will be
marked for purging.

5.  

Click the Continue button. Another Purge Journal Entries window will appear, listing all the accounts
in your chart of accounts.

6.  

From the list of accounts, select the accounts whose unreconciled journal entries you don't want to
purge. Typically, you should select the accounts you regularly reconcile in the Reconcile Accounts
window.

7.  

Click the Purge Journal Entries button. The journal entries for the time frame you specified and for
the accounts you didn't select in this window will be purged.

8.  

To purge journal entries

© MYOB Limited. All rights reserved.

Note: This is different than what you do with sales and purchases! Be sure to mark the accounts that
have unreconciled journal entries you don't want to be removed. (Don't make the mistake of marking the
accounts you do want to be removed as you do with sales and purchases.) Be careful when you make your
selections!



To purge activity slips

If you haven't already read the Month-end Procedures Overview, see Purging information that's no longer
needed for more information.

Please note that this task requires single-user access. See Single-user file locking for more information.

Print all the reports that you wish to keep that show the activity slips you'll be purging. You might
consider printing an Activity Slip Report for Completed Work, on which you can include whatever
information you need about the activity slips you're about to purge.

1.  

Make a backup of your data file. Clearly mark this backup and put it in storage as part of your
permanent records. (If you've just purged closed invoices, closed bills or journal entries and made a
backup during one of those procedures, it's not necessary to make another backup for activity slips.)

2.  

Open the Time Billing Command Center.3.  

Choose Purge Activity Slips from the File menu to open the Purge Activity Slips window.4.  

From the Purge Activity Slips BEFORE list, enter the first month from which you don't want to
remove activity slips. All activity slips dated prior to the month you select will be marked for
purging.

5.  

If you've assigned identifiers to people and companies in the Card File and wish to purge activity
slips for employees and vendors with the same identifier(s), enter the identifier(s).

6.  

Click the Continue button. Another Purge Activity Slips window appears, listing all the employees
and vendors in the Card File whose activity slips match the criteria you entered in the first Purge
Activity Slips window.

7.  

From the list, select the employees and vendors whose activity slips you want to purge. If you wish
to keep activity slips for any employees or vendors, click the x that appears next to that person's
name to remove it.

8.  

Click the Purge Activity Slips button.9.  

To purge activity slips

© MYOB Limited. All rights reserved.



To purge business contacts

If you haven't already read the Month-end Procedures Overview, see Purging information that's no longer
needed for more information.

Please note that this task requires single-user access. See Single-user file locking for more information.

Print all the reports that you wish to keep that show the business contacts you'll be purging. You
might consider printing a copy of the Contact Log Report, which contains detailed information about
all contacts.

1.  

Make a backup of your data file. Clearly mark this backup and put it in storage as part of your
permanent records.

2.  

Open the Card File Command Center.3.  

Choose Purge Contact Logs from the File menu to open the Purge Contact Logs window.4.  

From the Purge Contact Logs BEFORE list, choose the first month for which you don't want to
remove business contacts. All business contacts dated prior to the month you select will be marked
for purging.

5.  

Using the Card Type field, choose to purge business contacts for customers, vendors, employees or
personal contacts only, or to purge business contacts for all people and companies in the Card File.

6.  

If you've assigned identifiers to people and companies in the Card File and wish to purge business
contacts for contacts with the same identifier(s), mark the Identifiers option, then enter the
identifier(s).

7.  

Mark the Do Not Purge if Entry has a Recontact Date option if you don't want to remove business
contacts that have recontact dates assigned to them,

8.  

Click the Continue button. Another Purge Contact Logs window will appear, listing all the people and
companies in the Card File that match the criteria you entered in the first Purge Contact Logs
window. A mark appears in the X column next to each card name, indicating that the business
contacts for that card will be removed.

9.  

Click in the X column next to the card's name to remove the mark that appears there if you want to
keep business contact information for any of the cards that are displayed,

10.  

Click the Purge Contact Logs button.11.  

To purge business contacts
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To reconcile an account

If you haven't already read the Month-end Procedures Overview, see Reconciling checking accounts for more
information.The Reconcile Accounts window should be displayed.

Enter or select the account you want to reconcile in the Account field, and press tab.1.  

Enter the ending balance that appears on your bank statement in the New Statement Balance field.2.  

Enter the closing date that appears on your bank statement in the Bank Statement Date field. Only
unreconciled transactions dated on or before that date will appear in the scrolling list.

3.  

Click the Bank Entry button to open the Record Service Charges and Interest Earned window and
enter any bank service charges you owe and any interest that you earned.

4.  

Skip to step 6 if you've already entered the bank charges and interest transactions in AccountEdge before
opening the Reconcile Accounts window. These transactions should already appear in the transactions list.

Click Record. If you need to record additional bank charges or fees, click the Bank Entry button
again.

5.  

Mark each transaction in the scrolling list that appears on your bank statement. (Transactions
entered using the Bank Entry feature are automatically marked as cleared.)

6.  

Click the Reconcile button. A window appears, indicating whether your account is reconciled or is out
of balance.

7.  

If your account is reconciled, you can either reconcile the account or print the Reconciliation Report.8.  

To reconcile, click the Reconcile button; the transactions you marked are considered "cleared," and won't
show up in the Reconcile Accounts window the next time you open it. To print the report, click Print Report;
if you print the report, be sure to click Reconcile again to complete the reconciliation process after the
report's been printed.

To reconcile an account
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Note: If you're reconciling for the first time If you've never used the Reconcile Accounts window before,
there are some special steps that you should perform before you begin the reconciliation process. If this is
your situation, see To reconcile an account for the first time using AccountEdge. Note: Be sure to enter
the ending balance! Many bank statements have more than one balance on them. Be sure to enter the
balance of your account at the end of the period. Note: Use care when entering the date in the
Reconcile Accounts window The Reconciliation Report enables you to view the status of an account's
transactions as of a previous reconciliation date. If the bank statement date you enter in the Reconcile
Accounts window is different from the date that appears on the actual statement you received from your
bank, you may find it difficult to determine which date should be used to print the Reconciliation Report in
the future. Note: You may edit, remove or reverse entries using this window If the transaction
information displayed in the Reconcile Accounts window is incorrect, you can choose to click the zoom to
display the original transaction entry window.

If your records are changeable, you may edit the transaction. When you click OK, the updated information
will appear in the Reconcile Accounts window. If you choose Delete Transaction from the Edit menu to
remove the transaction, the transaction will no longer appear in the Reconcile Accounts window.

If your records are unchangeable, you may reverse the transaction by choosing Reverse Transaction from
the Edit menu. After a few moments, a new transaction, containing amounts exactly opposite to the original
transaction, will be displayed. When you click Record, the reversal will be added to the Reconcile Accounts
window. If you don't want the original entry and the reversal to appear the next time you reconcile, mark
both entries to indicate they are cleared.

See What are changeable and unchangeable transactions? for more information. Note: You must finish
reconciling after you print the Reconciliation Report! If you choose to print the Reconciliation Report,
be sure to click the Reconcile button again in the Reconcile Accounts window. When you choose to print the
report, the reconciling process is stopped, and you must click Reconcile again to complete the process.
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To reconcile an account for the first time using AccountEdge

If you haven't already read the Month-end Procedures Overview, see To reconcile an account for the
first time for more information.Create a General Journal entry for the checking account, with a
separate debit for each deposit that hasn't cleared yet and a separate credit for each check that
hasn't cleared yet.

1.  

It's unlikely that the debits will equal the credits in the General Journal Entry window. If the Out of
Balance field underneath the scrolling list shows an amount, you'll need to enter another line item
with an amount that balances the debits and credits.

2.  

Click Record.3.  

In the Checkbook Command Center, click Reconcile Accounts to open the Reconcile Accounts
window.

4.  

Enter the account you want to reconcile in the Account field. The checks and deposits you've
entered, as well as the individual line items in the General Journal entry you just created, appear in
the scrolling list in the middle of the window.

5.  

Enter the ending balance on the statement that your bank sent you in the New Statement Balance
field.

6.  

Enter the closing date that appears on your bank statement in the Bank Statement Date field. Only
the transactions dated on or before that date will appear in the scrolling list.

7.  

Mark all checks and deposits that are on your bank statement; also mark the balancing amount
entry you created in step 2.

8.  

Click Reconcile. A window appears, indicating whether your account is reconciled or is out of
balance.

9.  

If your account is reconciled, you can either reconcile the account or print the Reconciliation Report.10.  

Click Reconcile to reconcile the account. Click Print Report to print the report. If you print the report,
be sure to click Reconcile again to complete the reconciliation process after the report's been
printed.

11.  

In future months, when you receive bank statements that contain the other transactions you performed
before you began using AccountEdge, you can mark off the other line items from the General Journal entry.

To reconcile an account for the first time using AccountEdge
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To print the Tax Liabilities Report

If you haven't already read the Month-end Procedures Overview, see Paying payroll taxes for more
information.

The Index to Reports window should be displayed.

Select the Payroll tab to display a scrolling list of reports that are associated with the Payroll
Command Center.

1.  

Highlight the Tax Liabilities selection at the bottom of the list.2.  

Click the Filters button. You can choose a range of dates for which you want to view your payroll tax
liabilities. The taxes you owe on payroll checks printed during that time will be displayed.

3.  

Click OK to redisplay the Index to Reports window.4.  

Click the Print button.5.  

To print the Tax Liabilities Report
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To close an accounting period

If you haven't already read the Month-end Procedures Overview, see Closing accounting periods for
more information.If you've received statements from your bank, use the Reconcile Accounts window
to reconcile amounts in AccountEdge with the amounts on the statements. See Reconciling accounts
for more information about this task.

1.  

Print a Trial Balance (Detail) Report for the period. Check to see whether the activity that appears in
the report is what you expected; for example, zero amounts in accounts that usually have regular
activity may indicate a problem. See "To print a trial balance (or general ledger)" for more
information about this task.

2.  

If the information in the trial balance reports is acceptable, print the reports you want to keep as
part of your permanent business records. Suggested reports include the balance sheet, profit and
loss statement, Aged Payables Report, Aged Receivables Report and all journal reports.

3.  

Make a backup of your data file. Clearly mark this backup and put it in storage as part of your
permanent records.

4.  

Choose Preferences from the Setup menu to open the Preferences window.5.  

Select the Security tab.6.  

Change your selection in the Lock Periods list to the period you're closing.7.  

To close an accounting period
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Idea: Check your data file for errors before proceeding To be completely sure that your data file is
sound, we recommend that you use the AccountEdge data verification feature before you continue. You can
check your data for errors during the backup process, if you wish. For more information about data
verification, see Verifying data files .
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